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R0 45 UL, DA RS A B 2 Bl

File is not found.

IR A I R A 4K B S

File or folder already exists.

CLAFAE LG SRR B ORAT 1) SCAE /SO [ 44 R SCAE A K o

File or folder path is too long.

o1 T OB AR B AR I B K P AT Jok vl i) 48 2k ) ¥ S s
Ho

Folder is not empty.

TR B 75 B 1) SO K

lllegal bulk data.

PR R Bt R SR AR R H

lllegal file name.

PR LA AR 1 AR AN F ) B K

lllegal file. A 1A ToVE A P B I e S A
Keybank full. PATINBERAE ORI N e R A
Library full. PAT ARG, EORL P ) f K B L
MIDI buffer full. PRk — Uk B i 22 2 SR RE AL BEMIDIE ) .

MIDI checksum error.

2Rt R N R A A R

No data.

PR S EGEE A SR, I R R S PG .

m MONTAGE &




EEE

LCD &7

No read/write authority to the file.

RN TR 5 A

Now initializing all data...

FORAAT A IEAE R ) G B

Now initializing...

FORIEAEYIIR LT 2 s «

Now loading... KR IELE gt
Now receiving MIDI bulk data... RIRAE A IELE MDD = 4080
Now saving... KR IEAERAT L

Now transmitting MIDI bulk data...

BRAAT AR IEAEROEMIDIE R H i

Please connect USB device.

FUSB %% 2 [USB TO DEVICE] iy I 34T & A & .

Please keep power on.

IEAERS HdE 5 N INAFROM . 7245 58l 5 N INAFROMIN . 1273 P G T v
o AERRILAE BN SCH IR, K& B 2k, JF AR RES |
BARGRE (BT NAFROMA I BIBEE ) « KR AT RS FEUE T
UFTIT R MONTAGE G IEH# A 2 -

Please reboot to enable the new Audio I/O
Mode.

i T BAS s LA P A i N L ) B

Please reboot to maintain internal memory.

T EH A SIS AR WAL .

Please stop audio play/rec.

W BREAT (3R JCVEAE S IR 3 RO R 4R T

Please stop sequencer.

TR B AT (R TCVEAE SR R O R T T

Please wait...

FORAAT A IEAERAT TR A

Recall latest edits.

U R IEAE GRS 22 AN AE AR AP 2 RS AL O Pk 7 51— M
Z, WPHERI T DR S B o W SR BRSO, S mT (8 HI T H R
BB R LU 2241

Redo last recording.

AN 77 BRI IO B A

Sample is protected.

T i FEA K

Sample is too long.

SRFERNIE K HICTERAT I8 -

Sample memory full.

FEARAF At G HLIGE— AT Inds A

Scene stored.

Yy CAFE BI[SCENE %42 —.

Song data overload.

A il RS IR TSI

Song full.

PATHIDCERARI, OB SR i o R 2

Touch the white square.

A5 T ARORE 193] 22 5 A s ) 1 GBI, LA .

Turn on Memory Switch to memorize ** into
this scene.

LRHEINBEIT T [Memory]  GIEIZTTFR) I, W DI REAS B H Sl 476l 2
HI T I [SCENE]HZ 4R .

Undo last recording.

TN 1 S A ) il o

Unsupported USB device.

MR T AN FFIIUSBRE I, MG R

USB connection terminated.

T o, USBINARAERRAETHINS . MNUSB TO DEVICE
FIBTIFUSBINAF B A6, ARG 44— THARZ AL

USB device is full.

USBINAF B i, ANBEFFORAF 2 R 8. T AEAT B FUSBINAF L4, B
5 At B % v A P 800 LR 2 1)

USB device is write-protected.

NG NZ R USBINAF A I, B B

USB device read/write error.

XFUSBIAAF B B NN H 5

USB device will be formatted.

FER A USBRESG 2, HBLIAE .

Waveform full.

PATHIDCERARI, CHEBRIE KRR .
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R HERR

B EEAR? RSB, W LU R I J5, PR L T RO AR S B %1 BIUSBIN A7
Bk RS0 JaATHdvlinte  (BE53I0) WA 2 M. R M A RAE 4L, 1 % i Yamaha 2 f5 7 -

ARAR T #] TT 3% IE 8 IR 2 .

w S A AR A 1 U2 A TR T I R BRI TEA X 52
S AE i B IR o

[UTILITY] + PART [COMMON] > [ENTER]
[UTILITY] > [Settings] > [System] > [Calibrate Touch Panel]

HEFE
m TR AR E R AIE R (0 BN 2
m MONTAGE J& 15 1 ik ¥ Mgk IE A e B BIAH G A A B (ln, ORAR. # s, B ?
BT MONTAGE % N B F 2%, N EAMES R LW —BISLABETENA AT LOEMIEY (35 14 70 .
m A RS R A B s () A M W (R R S TR 2
n TR EREEHSE, AFEASERSNESTEU ML EIMNEEEN 2R E?
Lk da 28 5 [FOOT CONTROLLER] fEFLMER, 5 Bkl ge .
m ARHPE IS EUE T B ] ?
YRR SO e AN, AR, ASRIFE S,

[UTILITY] > [Settings] > [MIDI 1/0] > “Local Control”

m TR T 5
WA, VAR FERE 525 I P e LA 7 7

m & ARSI OGRS AT I ?
M OCHT TR, RIS, AN KA.
[PERFORMANCE] > /5 #FIE+ > “Mute”
m R B AR T O AT ?
[PERFORMANCE] > 75 #Fi% 4+ > “Kbd Ctrl”
m EFEER “Arp Play Only” ZHU2 1512
UL SEFT IR, 0 S A o I OR
[EDIT] > 7= i#li%$# > ELEMENT/OPERATOR [COMMON] - [Part Settings] > [General] > ‘Arp Play Only”
[EDIT] > B+ > ELEMENT/OPERATOR [COMMON] - [Arpeggio] > [Common] > ‘Arp Play Only”
w F MR IR, MIDI 3 5al MIDL 1 3 B A% ?
m R GRS R E LT EE?
WRAT SRS Ay, e SR AU R . SRl v A ] RS I R T R .
[EDIT] > PART [COMMON] > [Effect]
[EDIT] > 7 #i%# > ELEMENT/OPERATOR [COMMON] - [Effect]
o IHLEFRUEF R (AWM2) FHE: 7530
[EDIT] > 75 #fik$ > &5 / $ELFF > [Filter]
o IARFRHERE T (FM-XD
[EDIT] > FiBi£# > ELEMENT/OPERATOR [COMMON] - [Pitch/Filter]
m L TIERE “Vocoder” 114 I 4EH AR R 2

WA, L A/D INPUT [L/MONOY/R] 4 ALAHSR IS B B 0 B il (e, AR5 7ER R 0 7 5 i A\ i 4% ) MONTAGE
22 58 AR [ I 2 B . A A S AR L7 A/D INPUT [GAIN] Jie £ A2 75 v 1 B de /M

[EDIT] > 7 #i%# > ELEMENT/OPERATOR [COMMON] - [Effect] > [Routing]

m MONTAGE &



B HERR

m R R R TR ?
[UTILITY] > [Settings] > [Sound] > & “Volume”
[EDIT] > PART [COMMON] > [General] > “Volume”
[EDIT] > 7 #i%4% > ELEMENT/OPERATOR [COMMON] - [Part Settings] > [General] > “Volume”
[EDIT] > F#Bik$: > ELEMENT/OPERATOR [COMMON] - [Part Settings] > [General] > “Dry Level”
o W ALEAREFE T (AWM2) FIEs =3
[EDIT] > F#BIES: > &5 / #iLEH > [Amplitude] > [Level/Pan] > “Level”
o IAUEARMERE TS (FM-XO
[EDIT] > A HFIEFE > HAERER: > [Level] > “Level”
m HEIFR. S BRI JE RRHIR E R A S B T AIE?
o INALEFRUERE (AWM2) FlE 5 i
[EDIT] > % $: > ELEMENT/OPERATOR [COMMON] > [Part Settings] > [General]
[EDIT] > 7S #fiEHE > & % / #1% 5% > [Osc/Tune]
o IAUEARMEREES  (FM-XO
[EDIT] > F £+ > ELEMENT/OPERATOR [COMMON] - [Part Settings] > [General]
w IR ARSI S TR AT ?
[EDIT] > FH#fiEss > &5 2 /R ERINES T8
m MEEFRERT (FM-X), B TR Ry 072
[EDIT] > FEBIEFE > #RERRERE > [Level] > “Level”
m R AR S HOLE R ?
[EDIT] > F#Bik$: > ELEMENT/OPERATOR [COMMON] - [Part Settings] > [General] > “Part Output”

A/D INPUT $GEFL EE &I

m 350 RIS ST T 2

w AT AR, S B R

w3 SRR AT U A A S 2 2 ] AR 45 2 1 IE A B2 2

m A/D INPUT [GAIN] Jedl j& 1546 2 i /N ?

m A/D INPUT [ON/OFF] #4275+ 2

m {7 A/D INPUT [L/MONOJ/[R] HIEERE LB HF & “Mono/Stereo” 4.
[EDIT] » PART [COMMON] > [Audio In] > [Mixing] > A/D In “Input Mode”

m KA “Mic/Line” UL W B N A IEE.
MADEREE (TR B T RAR, RIS EOE N Mic”. UAIEREE G ke . CD FRBHL 11
W SR R, RS HOE N “Line”,

[UTILITY] > [Settings] > [Audio 1/0] > “A/D Input’
m A/D Gy NS ER 15 A A I ?
[EDIT] > PART [COMMON] > [Audio In] > [Mixing] > A/D In “Volume”
m R A ?
[EDIT] > PART [COMMON] - [Audio In] > [Routing]
m A/D Fy TR ) R R A ?
[UTILITY] > [Settings] > [Audio 1/0] > Output
m R TR T AR AR
%%3‘;%@2&1’5% SAHT A B I ARORIS, MBEEREE, M AD INPUT [L/MONOJ/[R] #&FLE A KI5 55 5 7] g A
=~ o

[EDIT] > 7 #i%# > ELEMENT/OPERATOR [COMMON] - [Effect] > [Routing]

wortace s [E



B HERR

FEREER

m % [ARP ON/OFF] $Z4HFT FFIT, 4% b5l AF 424 5 1A

w ESR AT P, dE (W] (i) FA.

m ARSI BRI S I, R AR W B T B R A .

" %ﬁiﬁ%ﬁﬁgiﬁ KA LU NS HUE .. BHSEE N “always” IAMNABRE, AT S ARSI, e
S AAER HIH o

[UTILITY] > [Tempo Settings] > Click “Mode”

BFEXRE.

m R BEE T I ?
FERLORE MERBCR AW e AR

[EDIT] > F#i%$#: > ELEMENT/OPERATOR [COMMON] > [Effect]
m R AR E R A ?

o v R R AR L R R S UK E
o MR RUER T (AWM2) Flah /i

[EDIT] > FE#BiES: > &3 / 5L+ > [Filter]
o IARFRHERE T (FM-XD

[EDIT] > F#i%$#: > ELEMENT/OPERATOR [COMMON] > [Pitch/Filter]
m SN T AT & S0 e I DA T AR ?

[UTILITY] > [Settings] > [Sound] > Tone Generator “Volume”

[UTILITY] > [Settings] > [Audio 1/0] > “Output”

[EDIT] > PART [COMMON] > [General] > “Volume”

[EDIT] > FiBi£# > ELEMENT/OPERATOR [COMMON] > [Part Settings] > [General] > “Volume”
o ISR RRUER . (AWM2) Rl 7 &

[EDIT] > FEEiik$: > &% / 8%k $ > [Amplitude] > [Level/Pan] > “Level”
o IARFRHERE T (FM-XD

[EDIT] > FH#BIERE > HAEARIEFE > [Level] > “Level”

AR
m BN CHMEERRBCNR i /P EE RO 2 MONTAGE i KEF L (AWM2 Hil FM-X 504 128)?

BRAENIEFLRE.
m A S OLIN, AR R ) R ) R SRR E ) “mono”.
RSN, RIS ECE ) “poly”s

[EDIT] > % $#: > ELEMENT/OPERATOR [COMMON] > [Part Settings] > [General] > “Mono/Poly”

BN EREIR.

n SAEHKESFWSEREWE R 0" DAMNIH T ?
[UTILITY] > [Settings] > [Sound] > Tone Generator “Tune”

m S S S VIR SHOE TR E N 07 LANK I EE?

o INALEFRUERT (AWM2) FlE 5
[EDIT] > f#Bi&k$: > ELEMENT/OPERATOR [COMMON] - [Part Settings] > [Pitch] > “Note Shift”
[EDIT] > mHifii£+ > ELEMENT/OPERATOR [COMMON] - [Part Settings] > [Pitch] > “Detune”

o WA RARMEFES  (FM-XO
[EDIT] > A ifii£+ > ELEMENT/OPERATOR [COMMON] - [Pitch/Filter] > [Pitch] > “Note Shift”
[EDIT] > £+ > ELEMENT/OPERATOR [COMMON] - [Pitch/Filter] > [Pitch] > “Detune”

m MONTAGE &



B HERR

w YT AERRR S SN, RIS B T SIS SRR
o I HLEARUMEREE (AWM2) Rl A
[EDIT] > 7%+ > ELEMENT/OPERATOR [COMMON] > [Part Settings] > [Pitch] > “Micro Tuning Name”
o WERSERREF . (FM-XO
[EDIT] > FiBi£# > ELEMENT/OPERATOR [COMMON] - [Pitch/Filter] > [Pitch] > “Micro Tuning Name”
w CYFEEAERNR S AN, LFO S R B T R A ?
o WERFENRMER T (AWM2)
[EDIT] > F#Bik#F > & 24 > [Element LFO] > “Pitch Mod”
o WERSERREF T (FM-XO
[EDIT] > F#i%$#: > ELEMENT/OPERATOR [COMMON] > [Mod/Control] > [2nd LFO] > “Pitch Modulation”
w Y FEET AR SN, R R AN R R T I ?
o W B EARHERTER  (AWM2) Rl
[EDIT] > i+ > &% / #iE 5 > [Osc/Tune] > “Coarse”
[EDIT] > HEBiES: > =& / #iEH > [Osc/Tune] > “Fine”
o WERSERREF . (FM-XO
[EDIT] > Bk + > HAE#RIEHE > [Form/Freq] > “Coarse”
[EDIT] > FH#BIESRE > HAE#R 1L+ > [Form/Freq] > “Fine”
w YL AR I, R HIRS ORI H IR T BCEY “Pitch”?
[EDIT] > ##Bi%$% > [Mod/Control] > [Control Assign] > “Destination”

KN RAMR-
m BRI O A ?
[UTILITY] > [Effect Switch]
m DAL R IE BRI R R R R E R 0" AN e ?
[EDIT] > 75 #164% > ELEMENT/OPERATOR [COMMON] = [Effect] > [Routing] > “Var Send”
[EDIT] > 75 #i%4 > ELEMENT/OPERATOR [COMMON] - [Effect] > [Routing] > “Rev Send”
m AR [P BRI R R A R B R “0” DAAMW e ?
[EDIT] > PART [COMMON] - [Effect] > [Routing] > “Var Returr’
[EDIT] > PART [COMMON] > [Effect] > [Routing] > “Rev Returr’
RIS AR S S0 O R E R R “thru”?
[EDIT] > % #%# > ELEMENT/OPERATOR [COMMON] - [Effect] > [Routing] > “Element 1-8”
m UHRERAROR, TSI A AR O E N “No Effect”?
RN, RS AR O “Thru”?
B EGATF RS T IEM R E .
[EDIT] > 75 #i%4 > ELEMENT/OPERATOR [COMMON] - [Effect] > [Ins Al/[Ins B]

ERHMEBE.
m f 7 [ARP ON/OFF] %4 A& $1 TRk 2 5%
m PSR TF AT IF U075 A
1858 %2 mT DA A I RR 700 \AS i B
w5 BR RN g 3 BR ) 45 B A O S HUE R IR B ?
[EDIT] > 754 > ELEMENT/OPERATOR [COMMON] - [Arpeggio] - [Common]
m SNSRI off"?

[EDIT] > 7= #iE$#¢ > [Arpeggio] > [Individual] > “Name”

MONTAGE f& it i m



B HERR

n A E T I RSH
BRI S HOR E N k], S [ARP ON/OFF] 4L4HAT T, AN St o SR AR V6 28 i A &8 7 L

[PERFORMANCE] > 74 #5t4% > “Arp On”

TEEFELES.
m U ORI, BE UL AT IR, 155G &SRS E N off.
[EDIT] > 75 #i%4% > ELEMENT/OPERATOR [COMMON] - [Arpeggio] > [Common] > “Hold”

BIE#RT [>] (BRD =B ITEFIBERURH
T S A A S o A R 2

FoIE R R

m TR AT A S R R /AL ?
MONTAGE f#fifi s fie 2 W Akl 64 1 A5 e G SRAFfd s O, WITGiksbl s 22 A 2%

T E#5 MONTAGE (8| f9#R BIE A EES .
w KA B F R R TR Y .
m K57 MIDI IN/OUT S#02 & s & iE(H .

[UTILITY] > [Settings] > [MIDI 1/0] > MIDI “MIDI IN/OUT”

MIDI it & 1% 1% / B A e EE TE.
m R SRR RS N G ?
KRB RS HORE T
[UTILITY] > [Settings] > [Advanced] > MIDI “Receive Bulk”
w R I R e i ) e A 16 T FLSEHIAE S MIDI B 45 h KT MID L S SR I, 75 224 MIDI& 4 G5 658 b 5 %326 IR AH ]
FRI1H -
[UTILITY] > [Settings] > [Advanced] > MIDI “Device Number”
IR TCIE IR TAER, &2 MONTAGE [ MIDI AR5 5 45 4 52 15 B BN 5 %4 4 5 S 5T RE ?
[UTILITY] > [Settings] > [Advanced] > MIDI “Device Number”

TR HARRFERISME USB INTFiR&.
w EAEAEFII USB INAF B2 A 2 25 R4 ? (AEORAF BRI, oA S ORGP BEED MDD &

m USB A7 Bt ERmT B e A /s A2 ?
FE HsRmE i, AR BEE N USB INAF I #r . R fr iy L7 pron i) USB INAF B m T L CRAEHD frfit i,

[UTILITY] > [Contents] > [Load]/[Store/Save]

m Yamaha J& R IEREE USB [NA7 4% H 3R 2
HrRUEAMER, S 54 7,

EE '43 7(5‘1 EES (KRR 3BR (BERR).
m XS LOD R R IR R s ENIA SRR,

m MONTAGE &



A

A MONTAGES: 88%#, “Pfij /7 s (WIUh S & /Mb)s)
MONTAGE7: 764, FSXg#E (WILG /s>
MONTAGESG: 614, FSXEAL (HIEh ) B /fl)E )
NER LN I SAEEHIA s
AWM2: 8%
FM-X: 8#ff:d%, 885k
g2 AWM2: 128 (K SARFE/EEIETE)
FM-X: 128 ()
EA=iRis 16/H (NE), FHmASER® (ADT, USB™
RV Ny
W TiE: 567 GB (E#hiehigkittsgm), H/: 1.75GB
w2l £71,900
EDL A% 1857
MR ARG TRWAX1 2B A, Ahx76F KR, A (A, B) x76FhHI2, E#URx15
TR
*2 AIDFBIr X7 A FP Y
<BFANRCRIST S ) TR 1 B DR T 20 A1 >
FEQ BHiBD , H—HMEQ (3B, B HEEQ (2B
HIP AR AR £1130,000 & 1%
R E 480 ppg (B HFFHEED
HE (BPM) 5-300
WERYSH SRl 64 il
* 58 16T . L 5
SRR SEI R e, SERF BN, SERFDIN/DTH
A MONTAGE 5 44430, SMF#0. 1
ey FH R 8 EBFIN (4 k)
TE £110,000Fh 274
H 256l
R E TR T 8 + ¥4 ()
He I TiE: 128 L, FIf': 2,048
Pt a% . ADBI AT, 255, THIES. MBS EIae . ERHINATX8
JEsIx8 AR el Bk
HoRG 7" TFTH 558 R VGA LCDfil 57
EcAn| [USB TO DEVICE]. [USB TO HOST]. MIDI [IN]/[OUT}/[THRU]. FOOT
CONTROLLER [1]/[2]. FOOT SWITCH [ASSIGNABLE]/[SUSTAIN].
OUTPUT (BALANCED) [L/IMONOJ/[R] (6.3 mm, “F#TRSHEAL) «
ASSIGNABLE OUTPUT (BALANCED) [LJ/[R] (6.3 mm, “FAFTRSHESL) «
[PHONES] (6.3 mm, Fr#AESLMR A BALEFL) « A/D INPUT [L/IMONOJ/[R]
(6.3 mm, FREFHETL)
R~F, g MONTAGES: 1,450 (i) x470 GX) x 160 (&) mm, 29 kg
MONTAGE7: 1,244 (%) x396 (&) x131 (&) mm, 17 kg
MONTAGE6: 1,037 (%) x396 (&) x131 (&) mm, 15kg
B ACHLJEZ . MW (A4 . Cubase AN

A FH 0 5 1) P 25 Ay HE RN B BT IR B ARG o 1 42 Yamaha Il R 8B ROR RS I B 45 . BOAR R . B Bl e
PHEA M ATRES A PR, I 8, 35 5 Mt YamahaZe B R A -
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A

A/D INPUT [GAINT FEEH ..o, 7
A/D INPUT [L/MONOV[R] 4L oo 12, 44
A/D INPUT [ON/OFF] 324 ..o, 7
ABS  CESFHIFIE ) (o 12,13
[AC IN] (AC HIJEZRIFRE) oo, 12
[ARP ON/OFF] (E&HIT/ ) Ml oo 7,24
[ASSIGN 1] F1 [ASSIGN 2] #%4H (AR IF % 1

2 e 6
[TASSIGN] FZEL ..o 8
ASSIGNABLE OUTPUT (BALANCED) [L] #1 [R] #fL
CTRS AT oo 12
[AUDITION] 3240 ..o 10, 21
B

DRI e 53
AL IR e 12
EEIBRIIEE oo 35
A5 A1) = (18] FH oo 10
A5 B 1] = [B] FH L. oo 10
GiT C 1] = [8] HZH oo 10
T e, 19
FRAEFTEE CAWM2) Lo 18
FRAEFTEE (FM=XD oo, 18
C

B e, 33
PRAEBRIREE e 33
PRAE BT e 33
[CATEGORY SEARCH] 425 ..o, 9
Lo e 35
RTNRE oo 29
EDEEL .o 8,28
T T LCD e 8
BB ZCAEIRE e 6
[CONTROL ASSIGN] HZ4H ..o, 8
CUDASE ..o 49,63
TER e, 32
D

DAW Ao 51
[DEC/NOT HZHH ..o, 9,17
B oo, 14
A B T e 25
TR e 23
E

[EDITT oo 9
EFFECT BEFR .o oeoeoe oo, 16
ELEMENT/OPERATOR [COMMON] #24H ..o, 10
ELEMENT/OPERATOR [MUTE] 3%4H ...coooovoveeii e 10
ELEMENT/OPERATOR [SOLOT4Z8H. ....ooovvvvveee 10
[ENTER] M ..o, 9

MONTAGE &

e e 14
TEXITTFZHH ..o 9
F

G e 35
IYRETFL e, 20
FOOT CONTROLLER [11/[2] AL vvovevevoieeeieee 12
FOOT SWITCH [ASSIGNABLE]/[SUSTAIN] #&L........... 12
G

BT 54
GIM e 18
TEHAETHT oo, 45
BT oo 18
FEBR e 9,16
H

T TFUEL oo 56
PRIEHTIE T B oo, 15
B T e 28
|

[INC/YES] 324 oo, 9,17
J

T2 e, 53
o2 OO OROPPOP 6
BEIEIGREE oo 33
AT s 40
BT e 23
K

FFHUBEIR o 45
KNOB POSITION [1] 1 [2] 328 c..o.oovoeeeeeeeeee 8
FEBIFT o 8
BRI e 26
PRIV oo 49
L

FEBEVF BN oo 49
TEAEANEE MIDL ERZE e 48
[LIVE SET]FHH. .o 9
T e, 39
M

FETUIR oo 44
[MASTER VOLUME] HHF oo, 6, 15
MIDI [IN]. [OUT]. [THRUT 3 oo 12
MIDE B D et 50
MIDI RIETIIE ... 48
MIDE ZR TS et 39
MIDE I .o 50
R e 17
[MOTION SEQ HOLD] (Bha&T P asfad) #edll............. 6



[MOTION SEQ ON/OFF] (ZhZ&&HFaIT / 29

FEETL oo, 7,25
[MOTION SEQ TRIGGER] (Zh&&F etk %4l....... 6
[MULTI] (ZR3dasdl 7
(o)

OCTAVE [-] B [+ 425 oo, 8
OUTPUT (BALANCED) [L/MONO] #I [R] 4fifl.  (TRS ~“F-#
BT 12
P

B e 24
B I e, 38
PART [COMMON] 5. 10
[PART CONTROL] L ..o, 9
PART [MUTE] 324, 10
PART [SOLOT 4B ..o, 10
[PERFORMANCE] #HL.......oovoeovseeeeeeeeeeee 9,22
[PERFORMANCE CONTROL]4ZHH «.ovovvvoeeeeevie 9
[PHONES] (HHL FEFL oo 12
Q

VI IBESUTE oot 55
PINT T oo, 40
FEBEARAE oo 33
S

SCENE [1] = [81 42 oo, 8,29
SEQ TRANSPORT $ZHH.......c.ooioeeeeeeeeeeeeeeee, 8
TR e, 23
FEBBIRE oo 33
TRIT IR Lot 21
TEFEEAL LI o, 17
[SHIFTTAZHH. .. oeoeeoeoeeeeeee e, 9
BRI oo, 8
BN T T oo, 17
BT BEBLIEII oo, 17
B8 e 19
[STANDBY/ON] FF 2 oot 12
[STORE] FHTL ... 9
T

TS e 6
U

[USB TO DEVICE] 3 oot 12,54
[USB TO HOST] 3l oo 12,50
USB TAE TR oottt 53
TUTILITYT oo 9
w

D e 6
X

TRIZIBEE oo, 19
B e 34
TEEHL oo, 8, 27

FEELTHEE oo, 7,27
Y

Yamaha Steinberg USB Driver ..........cccccoovviiiiiiiii, 49
THZEZINEE oo, 32
THZEATETED oo, 22
T 39
B 15
TEATETE oot 41
TEITIIE oo 50
B B 33
BB o, 33
TEBETMTIER oo 33
FHFUEE oo 18
TREIE oo, 18
TR e 39
Z

B e, 33
BRI ZE e, 18
A e 43
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GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright © 1989, 1991 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to
share and change it. By contrast, the GNU General Public License is
intended to guarantee your freedom to share and change free software—
to make sure the software is free for all its users. This General Public
License applies to most of the Free Software Foundation’s software and to
any other program whose authors commit to using it. (Some other Free
Software Foundation software is covered by the GNU Lesser General
Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price.
Our General Public Licenses are designed to make sure that you have the
freedom to distribute copies of free software (and charge for this service if
you wish), that you receive source code or can get it if you want it, that
you can change the software or use pieces of it in new free programs; and
that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to
deny you these rights or to ask you to surrender the rights. These
restrictions translate to certain responsibilities for you if you distribute
copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or
for a fee, you must give the recipients all the rights that you have. You
must make sure that they, too, receive or can get the source code. And
you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2)
offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author's protection and ours, we want to make certain that
everyone understands that there is no warranty for this free software. If
the software is modified by someone else and passed on, we want its
recipients to know that what they have is not the original, so that any
problems introduced by others will not reflect on the original authors'
reputations.

Finally, any free program is threatened constantly by software patents.
We wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program
proprietary. To prevent this, we have made it clear that any patent must
be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and
modification follow.

GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR
COPYING, DISTRIBUTION AND
MODIFICATION

0. This License applies to any program or other work which contains a
notice placed by the copyright holder saying it may be distributed
under the terms of this General Public License. The “Program”,
below, refers to any such program or work, and a “work based on the
Program” means either the Program or any derivative work under
copyright law: that is to say, a work containing the Program or a
portion of it, either verbatim or with modifications and/or translated
into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as
“you”.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running the Program is not restricted, and the output from the
Program is covered only if its contents constitute a work based on the
Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source
code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this
License along with the Program.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a
fee.
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You may modify your copy or copies of the Program or any portion of
it, thus forming a work based on the Program, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices
stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in
whole or in part contains or is derived from the Program or any
part thereof, to be licensed as a whole at no charge to all third
parties under the terms of this License.

¢) If the modified program normally reads commands interactively
when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a
notice that there is no warranty (or else, saying that you provide a
warranty) and that users may redistribute the program under
these conditions, and telling the user how to view a copy of this
License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the
Program is not required to print an announcement.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Program,
and can be reasonably considered independent and separate works
in themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based
on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who
wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise
the right to control the distribution of derivative or collective works
based on the Program.

In addition, mere aggregation of another work not based on the
Program with the Program (or with a work based on the Program) on
a volume of a storage or distribution medium does not bring the other
work under the scope of this License.

You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms
of Sections 1 and 2 above provided that you also do one of the
following:

a) Accompany it with the complete corresponding machine-
readable source code, which must be distributed under the terms
of Sections 1 and 2 above on a medium customarily used for
software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to
give any third party, for a charge no more than your cost of
physically performing source distribution, a complete machine-
readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,

€) Accompany it with the information you received as to the offer to
distribute corresponding source code. (This alternative is allowed
only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in
accord with Subsection b above.)

The source code for a work means the preferred form of the work for
making modifications to it. For an executable work, complete source
code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control
compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything
that is normally distributed (in either source or binary form) with the
major components (compiler, kernel, and so on) of the operating
system on which the executable runs, unless that component itself
accompanies the executable.

If distribution of executable or object code is made by offering
access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.



10.

You may not copy, modify, sublicense, or distribute the Program
except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under
this License will not have their licenses terminated so long as such
parties remain in full compliance.

You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Program or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying the
Program or works based on it.

Each time you redistribute the Program (or any work based on the
Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program subject to
these terms and conditions. You may not impose any further
restrictions on the recipients’ exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties to
this License.

If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence
you may not distribute the Program at all. For example, if a patent
license would not permit royalty-free redistribution of the Program by
all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to
apply and the section as a whole is intended to apply in other
circumstances.

Itis not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system, which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

If the distribution and/or use of the Program is restricted in certain
countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Program under this License may
add an explicit geographical distribution limitation excluding those
countries, so that distribution is permitted only in or among countries
not thus excluded. In such case, this License incorporates the
limitation as if written in the body of this License.

The Free Software Foundation may publish revised and/or new
versions of the General Public License from time to time. Such new
versions will be similar in spirit to the present version, but may differ in
detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program
specifies a version number of this License which applies to it and
“any later version”, you have the option of following the terms and
conditions either of that version or of any later version published by
the Free Software Foundation. If the Program does not specify a
version number of this License, you may choose any version ever
published by the Free Software Foundation.

If you wish to incorporate parts of the Program into other free
programs whose distribution conditions are different, write to the
author to ask for permission. For software which is copyrighted by
the Free Software Foundation, write to the Free Software Foundation;
we sometimes make exceptions for this. Our decision will be guided
by the two goals of preserving the free status of all derivatives of our
free software and of promoting the sharing and reuse of software
generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE
IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT
PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER
PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF
THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR
AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY
OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New
Programs

If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it free
software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach
them to the start of each source file to most effectively convey the
exclusion of warranty; and each file should have at least the “copyright”
line and a pointer to where the full notice is found.

<one line to give the program’s name and a brief idea of what it
does.>
Copyright © <year> <name of author>

This program is free software; you can redistribute it and/or modify it
under the terms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or (at
your option) any later version.

This program is distributed in the hope that it will be useful, but
WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.
See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software Foundation,
Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it
starts in an interactive mode:

Gnomovision version 69, Copyright © year name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details
type ‘'show w’. This is free software, and you are welcome to
redistribute it under certain conditions; type ‘show ¢’ for details.

The hypothetical commands ‘show w’ and ‘show ¢’ should show the
appropriate parts of the General Public License. Of course, the
commands you use may be called something other than ‘show w’ and
‘show c’; they could even be mouse-clicks or menu items—whatever suits
your program.

You should also get your employer (if you work as a programmer) or your
school, if any, to sign a “copyright disclaimer” for the program, if
necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program
‘Gnomovision’ (which makes passes at compilers) written by James
Hacker.

<signature of Ty Coon>, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program
into proprietary programs. If your program is a subroutine library, you
may consider it more useful to permit linking proprietary applications with
the library. If this is what you want to do, use the GNU Lesser General
Public License instead of this License.
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GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright © 1991, 1999 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL.
It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to
share and change it. By contrast, the GNU General Public Licenses are
intended to guarantee your freedom to share and change free software—
to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially
designated software packages—typically libraries—of the Free Software
Foundation and other authors who decide to use it. You can use it too, but
we suggest you first think carefully about whether this license or the
ordinary General Public License is the better strategy to use in any
particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not
price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for this
service if you wish); that you receive source code or can get it if you want
it; that you can change the software and use pieces of it in new free
programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors
to deny you these rights or to ask you to surrender these rights. These
restrictions translate to certain responsibilities for you if you distribute
copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a
fee, you must give the recipients all the rights that we gave you. You must
make sure that they, too, receive or can get the source code. If you link
other code with the library, you must provide complete object files to the
recipients, so that they can relink them with the library after making
changes to the library and recompiling it. And you must show them these
terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal permission
to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no
warranty for the free library. Also, if the library is modified by someone
else and passed on, the recipients should know that what they have is not
the original version, so that the original author's reputation will not be
affected by problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any
free program. We wish to make sure that a company cannot effectively
restrict the users of a free program by obtaining a restrictive license from
a patent holder. Therefore, we insist that any patent license obtained for a
version of the library must be consistent with the full freedom of use
specified in this license.

Most GNU software, including some libraries, is covered by the ordinary
GNU General Public License. This license, the GNU Lesser General
Public License, applies to certain designated libraries, and is quite
different from the ordinary General Public License. We use this license for
certain libraries in order to permit linking those libraries into non-free
programs.

When a program is linked with a library, whether statically or using a
shared library, the combination of the two is legally speaking a combined
work, a derivative of the original library. The ordinary General Public
License therefore permits such linking only if the entire combination fits its
criteria of freedom. The Lesser General Public License permits more lax
criteria for linking other code with the library.

We call this license the “Lesser” General Public License because it does
Less to protect the user’s freedom than the ordinary General Public
License. It also provides other free software developers Less of an
advantage over competing non-free programs. These disadvantages are
the reason we use the ordinary General Public License for many libraries.
However, the Lesser license provides advantages in certain special
circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it becomes
a de-facto standard. To achieve this, non-free programs must be allowed
to use the library. A more frequent case is that a free library does the
same job as widely used non-free libraries. In this case, there is little to
gain by limiting the free library to free software only, so we use the Lesser
General Public License.

In other cases, permission to use a particular library in non-free programs
enables a greater number of people to use a large body of free software.
For example, permission to use the GNU C Library in non-free programs

m MONTAGE &

enables many more people to use the whole GNU operating system, as
well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the
users’ freedom, it does ensure that the user of a program that is linked
with the Library has the freedom and the wherewithal to run that program
using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a “work
based on the library” and a “work that uses the library”. The former
contains code derived from the library, whereas the latter must be
combined with the library in order to run.

GNU LESSER GENERAL PUBLIC
LICENSE

TERMS AND CONDITIONS FOR
COPYING, DISTRIBUTION AND
MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms of
this Lesser General Public License (also called “this License”). Each
licensee is addressed as “you”.

A “library” means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The “Library”, below, refers to any such software library or work which
has been distributed under these terms. A “work based on the
Library” means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a portion
of it, either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter, translation is
included without limitation in the term “modification”.)

“Source code” for a work means the preferred form of the work for
making modifications to it. For a library, complete source code
means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library does
and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library’s
complete source code as you receive it, in any medium, provided
that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a
fee.

2. You may modify your copy or copies of the Library or any portion of it,
thus forming a work based on the Library, and copy and distribute
such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

€) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of
data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table,



the facility still operates, and performs whatever part of its
purpose remains meaningful.

(For example, a function in a library to compute square roots has a
purpose that is entirely well-defined independent of the
application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must
be optional: if the application does not supply it, the square root
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library, and
can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who
wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise
the right to control the distribution of derivative or collective works
based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so that
they refer to the ordinary GNU General Public License, version 2,
instead of to this License. (If a newer version than version 2 of the
ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices.

Once this change is made in a given copy, it is irreversible for that
copy, so the ordinary GNU General Public License applies to all
subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the
Library into a program that is not a library.

You may copy and distribute the Library (or a portion or derivative of
it, under Section 2) in object code or executable form under the terms
of Sections 1 and 2 above provided that you accompany it with the
complete corresponding machine-readable source code, which must
be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from
a designated place, then offering equivalent access to copy the
source code from the same place satisfies the requirement to
distribute the source code, even though third parties are not
compelled to copy the source along with the object code.

A program that contains no derivative of any portion of the Library,
but is designed to work with the Library by being compiled or linked
with it, is called a “work that uses the Library”. Such a work, in
isolation, is not a derivative work of the Library, and therefore falls
outside the scope of this License.

However, linking a “work that uses the Library” with the Library
creates an executable that is a derivative of the Library (because it
contains portions of the Library), rather than a “work that uses the
library”. The executable is therefore covered by this License.
Section 6 states terms for distribution of such executables.

When a “work that uses the Library” uses material from a header file
that is part of the Library, the object code for the work may be a
derivative work of the Library even though the source code is not.
Whether this is true is especially significant if the work can be linked
without the Library, or if the work is itself a library. The threshold for
this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure
layouts and accessors, and small macros and small inline functions
(ten lines or less in length), then the use of the object file is
unrestricted, regardless of whether it is legally a derivative work.
(Executables containing this object code plus portions of the Library
will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute
the object code for the work under the terms of Section 6. Any
executables containing that work also fall under Section 6, whether or
not they are linked directly with the Library itself.

As an exception to the Sections above, you may also combine or link
a “work that uses the Library” with the Library to produce a work
containing portions of the Library, and distribute that work under
terms of your choice, provided that the terms permit modification of
the work for the customer's own use and reverse engineering for
debugging such modifications.

10.

You must give prominent notice with each copy of the work that the
Library is used in it and that the Library and its use are covered by
this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the
copyright notice for the Library among them, as well as a reference
directing the user to the copy of this License. Also, you must do one
of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes
were used in the work (which must be distributed under Sections
1 and 2 above); and, if the work is an executable linked with the
Library, with the complete machine-readable “work that uses the
Library”, as object code and/or source code, so that the user can
modify the Library and then relink to produce a modified
executable containing the modified Library. (It is understood that
the user who changes the contents of definitions files in the
Library will not necessarily be able to recompile the application to
use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a
copy of the library already present on the user's computer system,
rather than copying library functions into the executable, and (2)
will operate properly with a modified version of the library, if the
user installs one, as long as the modified version is interface-
compatible with the version that the work was made with.

€) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy from
a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these materials
or that you have already sent this user a copy.

For an executable, the required form of the “work that uses the
Library” must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself
accompanies the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you
cannot use both them and the Library together in an executable that
you distribute.

You may place library facilities that are a work based on the Library
side-by-side in a single library together with other library facilities not
covered by this License, and distribute such a combined library,
provided that the separate distribution of the work based on the
Library and of the other library facilities is otherwise permitted, and
provided that you do these two things:

a) Accompany the combined library with a copy of the same work
based on the Library, uncombined with any other library facilities.
This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any
attempt otherwise to copy, modify, sublicense, link with, or distribute
the Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying the
Library or works based on it.

Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the Library
subject to these terms and conditions. You may not impose any
further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third
parties with this License.
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11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence
you may not distribute the Library at all. For example, if a patent
license would not permit royalty-free redistribution of the Library by all
those who receive copies directly or indirectly through you, then the
only way you could satisfy both it and this License would be to refrain
entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to
apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is implemented
by public license practices. Many people have made generous
contributions to the wide range of software distributed through that
system in reliance on consistent application of that system; it is up to
the author/donor to decide if he or she is willing to distribute software
through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain
countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Library under this License may add
an explicit geographical distribution limitation excluding those
countries, so that distribution is permitted only in or among countries
not thus excluded. In such case, this License incorporates the
limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time.
Such new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
“any later version”, you have the option of following the terms and
conditions either of that version or of any later version published by
the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published
by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs
whose distribution conditions are incompatible with these, write to the
author to ask for permission. For software which is copyrighted by
the Free Software Foundation, write to the Free Software Foundation;
we sometimes make exceptions for this. Our decision will be guided
by the two goals of preserving the free status of all derivatives of our
free software and of promoting the sharing and reuse of software
generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE
IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED
BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE LIBRARY “AS IS” WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK
AS TO THE QUALITY AND PERFORMANCE OF TH LIBRARY IS WITH
YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR
AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY
OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF
THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN
IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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How to Apply These Terms to Your New
Libraries

If you develop a new library, and you want it to be of the greatest possible
use to the public, we recommend making it free software that everyone
can redistribute and change. You can do so by permitting redistribution
under these terms (or, alternatively, under the terms of the ordinary
General Public License).

To apply these terms, attach the following notices to the library. It is safest
to attach them to the start of each source file to most effectively convey
the exclusion of warranty; and each file should have at least the
“copyright” line and a pointer to where the full notice is found.

<one line to give the library’s name and a brief idea of what it does.>
Copyright © <year> <name of author>

This library is free software; you can redistribute it and/or modify it
under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but
WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.
See the GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-
1301 USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your
school, if any, to sign a “copyright disclaimer” for the library, if necessary.
Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the library
‘Frob’ (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990
Ty Coon, President of Vice

That's all there is to it!

libpng

This copy of the libpng notices is provided for your convenience. In case
of any discrepancy between this copy and the notices in the file png.h
that is included in the libpng distribution, the latter shall prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately
following this sentence.

This code is released under the libpng license.

libpng versions 1.0.7, July 1, 2000, through 1.6.18, July 23, 2015, are
Copyright © 2000-2002, 2004, 2006-2015 Glenn Randers-Pehrson, and
are distributed according to the same disclaimer and license as libpng-
1.0.6 with the following individuals added to the list of Contributing
Authors:

Simon-Pierre Cadieux

Eric S. Raymond

Mans Rullgard

Cosmin Truta

Gilles Vollant

James Yu

and with the following additions to the disclaimer:

There is no warranty against interference with your enjoyment of the
library or against infringement. There is no warranty that our efforts or the
library will fulfill any of your particular purposes or needs. This library is
provided with all faults, and the entire risk of satisfactory quality,
performance, accuracy, and effort is with the user.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are
Copyright © 1998-2000 Glenn Randers-Pehrson, and are distributed
according to the same disclaimer and license as libpng-0.96, with the
following individuals added to the list of Contributing Authors:

Tom Lane

Glenn Randers-Pehrson

Willem van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are
Copyright © 1996-1997 Andreas Dilger, and are distributed according to
the same disclaimer and license as libpng-0.88, with the following
individuals added to the list of Contributing Authors:

John Bowler

Kevin Bracey



Sam Bushell
Magnus Holmgren
Greg Roelofs

Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are
Copyright © 1995-1996 Guy Eric Schalnat, Group 42, Inc.

For the purposes of this copyright and license, “Contributing Authors” is
defined as the following set of individuals:

Andreas Dilger

Dave Martindale

Guy Eric Schalnat

Paul Schmidt

Tim Wegner

The PNG Reference Library is supplied “AS IS”. The Contributing Authors
and Group 42, Inc. disclaim all warranties, expressed or implied,
including, without limitation, the warranties of merchantability and of
fitness for any purpose. The Contributing Authors and Group 42, Inc.
assume no liability for direct, indirect, incidental, special, exemplary, or
consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.

Permission is hereby granted to use, copy, modify, and distribute this
source code, or portions hereof, for any purpose, without fee, subject to
the following restrictions:

1. The origin of this source code must not be misrepresented.
2. Altered versions must be plainly marked as such and must not be
misrepresented as being the original source.

3. This Copyright notice may not be removed or altered from any source
or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without
fee, and encourage the use of this source code as a component to
supporting the PNG file format in commercial products. If you use this
source code in a product, acknowledgment is not required but would be
appreciated.

A “png_get_copyright” function is available, for convenient use in “about”
boxes and the like:
printf("%s", png_get_copyright(NULL));

Also, the PNG logo (in PNG format, of course) is supplied in the files
“pngbar.png” and “pngbar.jpg” (88x31) and “pngnow.png” (98x31).

libpng is OSI Certified Open Source Software. OSI Certified Open Source
is a certification mark of the Open Source Initiative. OSI has not
addressed the additional disclaimers inserted at version 1.0.7.

Glenn Randers-Pehrson
glennrp at users.sourceforge.net
July 23, 2015

libuuid

Copyright: 1996, 1997, 1998, 1999, 2007 Theodore Ts'o.
1999 Andreas Dilger (adilger@enel.ucalgary.ca)

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice,
and the entire permission notice in its entirety, including the disclaimer
of warranties.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote
products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, ALL OF WHICH ARE HEREBY DISCLAIMED. IN
NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF NOT ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

-Qt

/
** Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).
** Contact: http://www.qt-project.org/legal

*

** This file is part of the examples of the Qt Toolkit.

** $QT_BEGIN_LICENSE:BSD$

** You may use this file under the terms of the BSD license as follows:

** "Redistribution and use in source and binary forms, with or without

** modification, are permitted provided that the following conditions are

** met:

** * Redistributions of source code must retain the above copyright

** notice, this list of conditions and the following disclaimer.

** *Redistributions in binary form must reproduce the above copyright

**  notice, this list of conditions and the following disclaimer in

**  the documentation and/or other materials provided with the

** distribution.

*** Neither the name of Digia Plc and its Subsidiary(-ies) nor the names

**  of its contributors may be used to endorse or promote products
derived

** from this software without specific prior written permission.

*%

*ox

** THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS

**"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT

**LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR

** A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT

** OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL,

** SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT

** LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE,

** DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY

** THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT

** (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE

** OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE."

*%

** $QT_END_LICENSE$
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